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Introduction
by Alco Blom 

If you are anything like me, you've probably got a growing number user IDs, passwords, 
registration keys, PINs, serial numbers, and the like, stored in various places on your Mac or 
scribbled on miscellaneous pieces of paper around your home or office. When you stop and 
think about it, you probably have more of these pesky bits of information scattered about than 
you realize. 

The proliferation of the Internet is exacerbating this situation. Increasing numbers of 
commercially-oriented sites, such as the NY Times, require some form of registration even 
simply to view content. Other transaction-oriented sites, such as Amazon.com, or personalized 
sites, such as My Yahoo, require passwords for personal services. Many sites now use cookies 
to track users, but if your cookies files get deleted or corrupted, you'll have to re-enter your 
usernames and passwords. 

I decided to write a software program to manage passwords and the like; it is called Web 
Confidential. It uses an intuitive, easy-to-use cardfile metaphor which will enable even novice 
users to get up to speed in no time. Power users will find a large number of options to enable 
them to configure Web Confidential to meet their specific needs. I think you will be especially 
impressed by the tight integration Web Confidential offers with your favorite Internet 
applications, such as Netscape Navigator, Microsoft Internet Explorer, Fetch and Interarchy. 
I've taken full advantage of the Mac OS's outstanding facilities, such as Interapplication 
Communication and Shared Menus, to make Web Confidential work seamlessly with these 
programs. 

Last but not least, Web Confidential permits you to encrypt your password files, protecting this 
sensitive information from prying eyes, using the state-of-the-art "Blowfish" algorithm [1]. The 
Blowfish algorithm was published four years ago, and has been proven extremely resilient to 
cracking. No known successful cryptanalysis against Blowfish exists. 

Web Confidential supports keys of up to 448 bits in length. 

Note: Palm and Windows versions of Web Confidential are also available. Please check the 
Home Page for details. 

[1] - Applied Cryptography, Bruce Schneier, 1996. John Wiley & Sons, Inc.
(see also http://www.counterpane.com/blowfish.html) 

http://www.web-confidential.com/
http://www.counterpane.com/blowfish.html


Installation

Web Confidential for Mac is a Macintosh program. (Web Confidential is also available for 
Palm and Windows). It runs on both Mac OS X and Mac OS 9. A Conduit for the Macintosh is 
supplied with the Palm version to synchronize data between your Macintosh and Palm. The 
files of Web Confidential are binary compatible on Mac and Windows and are truely cross-
platform. 

Web Confidential runs in 2 Mb of RAM. Including this help documentation, it requires around 
4 Mb of hard disk space. 

Web Confidential 3.7 requires Mac OS X 10.2 or higher. 

Web Confidential 3.7 is localized in English, Japanese, German, French, Spanish, Italian and 
Dutch. 

Web Confidential 3.6 is still available and runs on Mac OS 9 and Mac OS X. 

Web Confidential 2.2 is still available for Mac OS 7 and Mac OS 8. 

When Web Confidential is first run, it installs the Shared Menus Component. 

More information about Shared Menus is described in the Shared Menus Help. 

The Startup Items and Cabinet folders are special folders to store your password files in. 
Please read about them in the Reference section. 

help:openbook=Shared%20Menus%20Help


Support
Web-Confidential-Talk is a mailing list dedicated to the discussion of Web Confidential. The 
author of Web Confidential participates on the list and provides support. 

To subscribe to Web-Confidential-Talk, go to this Web Page:

    http://www.web-confidential.com/talk.html 

To make changes in your subscription, go here:

     http://www.web-confidential.com/change.html 

Before emailing support, please read the FAQ first. 

You can contact technical support at:

     support@web-confidential.com

Limitation of Liability

Under no circumstances including negligence, shall Alco Blom be liable for any incidental, special 
or consequential damages that result from the use or inability to use Web Confidential, even if Alco 
Blom has been advised of the possibility of such damages. 

http://www.web-confidential.com/talk.html
http://www.web-confidential.com/change.html
http://www.web-confidential.com/faq.html
mailto:support@web-confidential.com


The Concept Of Shareware
Web Confidential is distributed under the so-called "shareware" principle. This means that you 
are expected to pay a modest registration fee of $20 (or €20) if you continue to use the program 
beyond a trial period of 30 days. Within this trial period, you have full access to all of Web 
Confidential's features. After thirty days of use, you cannot add new cards but you can continue 
to view and edit existing cards. Upon payment of the registration fee, you will be issued a 
registration key which removes these restrictions. Payment of the registration fee entitles you to 
all subsequent incremental upgrades. In addition, the wishes of registered users will be taken 
into account in future enhancements of the program. 

Although freely distributed via the Internet and on CD-ROM collections, Web Confidential is 
not public domain software; it is commercial software which is professionally developed and 
supported. It represents many hours of work by its developer, whose primary source of income 
is derived from the development of shareware software for the Mac. Your registration payment 
ensures the continued viability of high-quality software developed by independent developers 
committed to the Mac. 

We trust that you will honor the shareware concept and register Web Confidential if you 
continue to use it. To encourage you to pay the shareware fee, the unregistered version of Web 
Confidential has the following restriction: 

After 30 days of use, you cannot add any new records to your files. However, you can still view 
and edit your existing data. After you register the program, this restriction is removed. 

Ordering Web Confidential

Web Confidential for Macintosh costs $20 or €20. You can register here: 

    Kagi Online Order Page    or   PayPal 

To order upgrades, go here: 

    eSellerate Web Store 

Web Confidential for Palm is a separate product and costs $15. If you want both programs, the 
price for the bundle is $30. 

There is a special bundle price if you also purchase URL Manager Pro. The bundle price is US 
$50, including three programs. URL Manager Pro is the professional bookmark manager for 
the Mac, see http://www.url-manager.com.

http://order.kagi.com/?AB
http://www.web-confidential.com/paypal.html
http://store.esellerate.net/s.asp?s=STR676348566
http://www.url-manager.com/


Getting Started

The Getting Started section contains a brief tutorial to help you get up to speed quickly using 
Web Confidential. In it, you will be introduced to the following topics: 

●     Storing your passwords in Web Confidential 
●     Using your passwords while surfing 

❍     Key Lock Shared Menu 
❍     The Dock passwords popup menu 

●     The Card Info Window 
●     Working with passwords in WWW Forms 
●     Launching a password-protected page 
●     The Web Confidential toolbar 

In Web Confidential you view your passwords in a list view. Use the categories popup menu 
in the toolbar to switch to any of fourteen pre-defined categories. Use the search field of the 
toolbar to find a password. 

Storing your passwords in Web Confidential

To add cards in Web Confidential, proceed as follows: 

Double click on the Web Confidential application icon to start the program. Use the New 
command from the File menu to create a new password file. Your new password file will be 
assigned the name "Untitled1". 

Let's start by creating a card for your email account. Typically, you were issued a user ID 
and password when you opened your account. We will now create a Web Confidential card 
containing this information. 

By default, Web Confidential displays a card structured for a web page. This means that each 



of the four fields is labeled appropriately for a Web page. 

To select a different category, click the card category popup menu - it currently displays 
"WWW Forms". 

Select "Email Accounts". An Email Account card is the appropriate card type for storing the 
details of your POP or IMAP email account. 

Use the Add Card command from the Card menu to create a card. You will be presented 
with an empty card. 

 

- The Add Card sheet Web Confidential - 

In the field Name, enter your name. 

In the field Server, enter the name of POP or IMAP server, for example: mail.mac.com. 

In the field User ID, enter your user ID. Do not confuse this with your real name; you user 
name will be one word with no spaces. It is usually a combination of letters from your first 
and last name. For example, it could be: gregb. 

In the field Password, enter your password. Please enter exactly as it was issued. 

Notice that your password is not displayed as you type, but rather bullets are substituted for 
each letter. This is for reasons of confidentiality, namely to prevent an onlooker from being 
able to see your password. 

To ensure, however, that you have indeed entered your password correctly, you can view it 
by moving your mouse pointer over the Eyeglasses icon next to the password field. This will 
display your password in a Help Balloon or Help Tag. 



Click the disclosure triangle to add a note. Add here the email address which is associated 
with this account, for example: gregb@mac.com. 

Use the OK button to add the card to your password file. 

You have now created your first Web Confidential card. Before you go any further, take a 
moment to save this password file to disk. However, we still need to specify the passphrase 
we are going to use to encrypt this file. Choose the command Enter Passphrase from the File 
menu. In the resulting sheet, also click the Help button to get some more info about how to 
optimally choose your passphrase. Enter you passphrase and repeat it in the Verify field of 
the passphrase sheet. Click OK to dismiss the sheet. Your passphrase for this password file is 
now set. 

Choose the Save command from the File menu. The Save File dialog will prompt you for a 
file name for your password file. The Web Confidential default is "Untitled1"; presumably 
you will want to change this to something more meaningful to you, for example: 'My 
Passwords'. Once you have given your Web Confidential password file a distinctive file 
name, simply periodically using the Save menu command of the File menu will save changes 
to your password file as you work. (A preferences to automatically save is also available.) 

Regarding the location of your password file on your hard disk: I advise you to store it in the 
Documents directory of your Home directory. More precisely, I would like that you create a 
folder named Passwords in your Documents directory and a folder named Startup Items in 
your Passwords directory. Put your password file in this Startup Items directory. 

When Web Confidential is launched the next time, it will open your password file 
automatically and ask you for your encryption passphrase. 

Using your passwords while surfing

While surfing and browsing web pages, you can have access to your passwords stored in 
Web Confidential through two different ways. One is via the menu bar of your browser. The 
other one is via the Web Confidential icon in the Mac OS X Dock. We will first look at the 
Key Lock Shared Menu. 

Key Lock Shared Menu

You will notice that Web Confidential has added two icon menus to the menu bar of your 
browser: the Web Confidential application icon menu and the Key Lock icon menu. 

(The Safari, Mozilla and FireFox browsers also show the Key Lock icon menu when you 
have installed the Shared Menus Enhancer, for more information see: http://www.web-
confidential.com/sme.html). 

(If the Diamond icon menu is showing, choose Preferences from the Diamond menu, click 
the Appearance tab, and enable the 'Go into Web Confidential mode' preference.) 

http://www.web-confidential.com/sme.html


 

- The menu bar of the Microsoft Internet Explorer and Web Confidential's icon menus - 

Using the Key Lock Shared Menu, you can access your passwords as easily as you can 
access your browser's bookmarks. The Key Lock Shared Menu shows all the password 
categories and each category shows all passwords in that category. 

 

- The Key Lock Shared Menu showing all Web Confidential's categories - 

The Dock passwords popup menu

The second way to access your passwords is via the Mac OS X Dock. 

While surfing, do a Control-Click on the Web Confidential icon in the Mac OS X Dock to 
get the Dock passwords popup menu. The Dock passwords popup menu shows all the 
password categories and each category shows all passwords in that category. It is shown 
below. 



 

- The Mac OS X Dock popup menu of Web Confidential giving access to your passwords - 

The Card Info Window

Choosing a menu item of the Key Lock Shared Menu or the Dock popup menu will show the 
Card Info Window. 

The Card Info Window, which gives you an overview of the password data that is stored in 
the card, is shown below. 



 

- The Card Info Window showing all items of your password data - 

The commands available are: 

●     Moving your mouse pointer over the lower Clipboard icon shows the password in a 
Help Tag 

●     Clicking the top Internet Location icon loads the URL from the card 
●     Clicking the top Clipboard icon copies the user ID to the Clipboard 
●     Clicking the bottom Clipboard icon copies the password to the Clipboard 
●     Clicking the Password button fills in the password field of the browser window 
●     Clicking the ID & Password button tries to fill in the user ID and password field of the 

browser window 
●     Clicking the Submit button tries to fill in the user ID and password field of the browser 

window and submit the WWW Form 
●     Clicking the Close button dismisses the Card Info Window 
●     Clicking the Help button gives help text 

Each card of the WWW Forms category will also already send the URL of the card to the 
web browser, while the Card Info Window is being opened. This useful, because the browser 
will load the web page containing the WWW Form and when it has finished loading, you can 
use the buttons of the Card Info Window to enter your password information.

If you hold down the Option key or the Command key while making a menu item selection, 
the card will not be loaded automatically and leaves it up to you to click the Internet 
Location icon.

Working with passwords in WWW Forms

Some sites, such as Amazon.com, or personalized sites, such as My Yahoo, require 
passwords for personal services. You can store these passwords in the category WWW 
Forms. Put all your data that concerns WWW Forms in the WWW Forms category. 

Choosing an item from the WWW Forms sub menu displays the Card Info Window for that 
item (see below). 



 

- The Card Info Window showing all items of your password data - 

Whenever you need to supply a password on a Web Page in a so-called WWW Form you 
can try to use the Password button in the Card Info Window to enter the password 
automatically. 

Below is a part of the form on the Amazon.com Account Access Web Page. Just pressing the 
Password button in the Card Info Window automatically sets this password field. It is not 
even necessary to use Paste! 

 

- The login page of Amazon.com - 

Many sites, like in the example above, actually require two pieces of information. A user ID 
and a password. You can use the ID & Password button to enter these two fields 
automatically. After pressing the ID & Password button the dialog is dismissed. 

You can even try to also automatically submit the form. Pressing the Submit button will first 
enter the user ID and password field and then submit the form. 

Below an example where you can press the Submit button of the Card Info Window and 
you will successfully log into Yahoo! 



 

- A WWW Form on the Yahoo.com web site - 

Launching a password-protected page

See how Web Confidential can automate logging into a password-protected Web Page by 
trying this: 

Add a new card to your password file in the "WWW Sites" category. Here is an URL for a 
page that is password-protected:

    http://www.web-confidential.com/bond/ 

Now enter in the User ID field:

    james

and in the Password field: 

    bond007 

Don't forget to enter a name in the first field; let's call it:

    Top Secret Page 

Next, locate the popup menu next to the URL field (the popup menu has a check mark icon). 
Now, please check the menu item "Automatic Access". 

You can now launch this page directly by clicking the Go button in the Toolbar. Web 
Confidential automates the authorization process for you, making viewing password-
protected pages as easy as unprotected ones. 

Note: this type of web page access is called HTTP Authentication. 

The Web Confidential Toolbar

http://www.web-confidential.com/bond/


 

- The configurable toolbar of Web Confidential - 

Now let's turn to the toolbar of Web Confidential. The most important functions for 
manipulating cards have been assigned buttons on the toolbar. You can modify the toolbar 
with the menu command Customize Toolbar from the Window menu. 

The Go opens a password card, using directly the URL specified in the second field. It does 
this by starting the appropriate application and supplying it with this URL. 

For example, create a WWW Forms card using an URL from your bookmark file or any 
other source. First select WWW Forms from the Category popup menu. Then click Add. 
Now fill in the fields as you see fit. When you are done, click OK. 

Now, click on the Go button. If your Web Browser is not currently open, it will be opened 
with the URL in field two as the URL destination. If your web browser is already open, this 
URL will be passed to it. In either case, your web browser will then try to load this page. 

The second button from the left, the Copy button, allows you to copy a password to the 
Clipboard and paste it into another application. This saves you having to enter your password 
manually. 

The Action button allows you to perform an action on the currently selected card. Clicking 
on the Action button, shows a popup menu with several commands. You get the same menu 
when you Control-Click on a card in the list view. 

The Search toolbar item enables you to search cards. 

This concludes the Getting Started with Web Confidential section. By now, you have been 
acquainted with the main features of Web Confidential. You can explore the program further 
on your own or use the Reference section to learn about additional specific features. 



Categories
There are fourteen categories in Web Confidential: 

●     WWW Forms, 
●     WWW Sites, 
●     FTP Servers, 
●     Newsgroups, 
●     Login Accounts, 
●     Email Accounts, 
●     Online Banking, 
●     Bank Accounts, 
●     Credit Cards, 
●     ATM/PIN Cards, 
●     Personal Data, 
●     Software Keys, 
●     Serial Numbers, 
●     Membership Numbers 
●     Miscellaneous. 

With regard to the WWW, you can use the categories "WWW Forms" 
and "WWW Sites". 

There are two types of Password Protected Web Sites. One type uses 
HTTP Authentication to gain access to a web site. You will know if the 
site is using HTTP Authentication because when you try to bring up the 
site, a dialog box will appear asking you for specific password 
information. Please store this information in the "WWW Sites" category. 
The other type of Password Protected Site asks for a password via a web 
form. Therefore, you would actually enter your information into a web 
page rather than a dialog box. Store these passwords in the category 
"WWW Forms". 

In "FTP Servers" you store your user ID and password to get access to 
password- protected FTP Servers. 



In "Newsgroups" you store your user ID and password to get access to 
password- protected newsgroups. 

In "Login Accounts" you store information you need to access the various 
UNIX and PPP accounts at ISP (Internet Service Providers) you have. 

In "Email Accounts" you store the passwords you need to retrieve mail 
from your various mailboxes. 

In "Online Banking" you store the web pages and access information of 
your several banks. 

In "Bank Accounts" you store the bank numbers you have. 

In "Credit Cards" you store the numbers and expiration dates of your 
credit cards. 

In "ATM/PIN Cards" you store the numbers of your ATM/PIN cards. 

In "Personal Data" you store data like your drivers license, your insurance 
policy, your social security number. 

In "Software Keys" you store all the registration numbers or software 
keys that you have received after registering software programs. 

In "Serial Numbers" you store the serial numbers of various equipment 
that you have in the house. The serial numbers of your VCR, TV, HIFI, 
PowerBook and Mac. You might need them if they ever get stolen. 

In "Membership Numbers" you can store various identification numbers 
that you receive after you join an organization or group. 



Web Confidential Command Reference

Web Confidential Main Window

Web Confidential's document window shows your passwords in a list view. 

The list view of Web Confidential comprises the following elements (from top to bottom): a 
toolbar, which contains the category popup menu, the column headers and the list of 
password items. In the lower left of the window is shown the number of items in the 
currently selected category. When you start typing and use the Type Ahead feature, this 
place shows the letters you have typed in. 

Moving your mouse while over the password field in the list, you can have a peek at your 
password in a help tag. In a similar way, moving your mouse while over the name field, will 
show the URL of the password item in a help tag. Moving your mouse while over the note 
field, will display the complete note in a help tag. 

You can click on a column header to sort the list. You can also rearrange the order of the 
columns by dragging them to their new position. You can use the Type Ahead feature to 
select a password item in the list by typing the first few letters of the name of the item. 

You can Control-Click on a password item in the list to get its Contextual Menu. The 
Contextual Menu enables you to copy data from the several fields of a card to the Clipboard. 

 

Web Confidential Add Card Sheet

The Add Card sheet enables you to add a card. A card's data contains the password and 
several data associated with it, such as the name and URL of a web page. You can also add a 
note. 



 

Web Confidential toolbar

The toolbar comprises the following buttons, which offer quick access to the main features 
of the program: 

 

Please note that the toolbar can be customized using the 'Customize Toolbar' command from 
the Window menu. 

Go
The Go button launches the URL of the selected password item. It does this by starting the 
appropriate application and supplying it with this URL. If the application is already open, 
this URL will be passed to it and the browser will try to load this page in its currently active 
window. 

Copy
The Copy button allows you to copy a password to the Clipboard and paste it into another 
application. This saves you having to enter your password manually. 

User ID
The User ID button copies the user ID to the Clipboard. 

Add
The Add button allows you to add a new, blank card to your current password file. It adds a 
new card of the type currently selected in the card category popup menu. To add a card of a 
different type than currently displayed, first select a different type using this menu, then 
press Add. 



Edit
The Edit button allows you to edit the current card. 

Delete
The Delete button allows you to delete the current card. 

Action
The action popup menu enables you to perform an action on a card, like, for example, 
copying the data from one of its fields to the clipboard. 

Search
One of the most important items in the toolbar, it enables you to search for a password. 

Save
The Save button saves your data to disk. Depending on the setting "Encrypt on Save" (that 
you can set via the command Set Passphrase from the File menu), the file is saved normally 
or encrypted. 

Card Fields

Each card in Web Confidential has four standard fields. They are labeled in various ways, 
depending on the type of card you have selected using the card category popup menu. In 
addition to the four standard fields, there is an optional note field for adding miscellaneous 
information about each card. By default, this is not displayed; to view or edit the contents of 
a note field, activate the Show Note disclosure triangle in the lower left hand corner of the 
add card sheet. 

To the right of the fourth field is the Eyeglasses icon. This displays the contents of the 
password field in a Help Tag. 

Card Attributes

Card Attributes are set via the checkbox and the preferred browser popup menu in the add 
card sheet. 

These are the two Card Attributes that you can set: 

Preferred browser 
If you want to open a card in a specific browser, you can set the preferred browser for a card 
here via the preferred browser popup menu. Default: your standard browser. 

In a new window 
If the "In a new window" attribute is set, this card will be opened in a new window in your 
browser rather than an existing window. Default: off. 



Web Confidential Menu bar

File menu

The File menu has the following commands: 

New
The New command creates a new empty password file. When you save it for the first time, 
you will be prompted for a distinctive file name. 

Open
The Open command provides you with a file selection dialog with which you can open an 
existing password file. 

Quick Open
The Quick Open command lists the files found in two folders: "Startup Items" and 
"Cabinet". Quick Open is a convenient way to open files without going through the file 
selection dialog. You can find more information about the "Startup Items" and "Cabinet" 
folders in the section "Special Folders" below. 

Close
The Close command closes the currently active password file. If you have modified it, you 
will be prompted to save changes before closing it. 

Save
The Save command writes the currently active password file to disk. 

Save As
The Save As command enables you save the currently active password file under a different 
name. 

Revert
The Revert command enables you retrieve the previously saved version of the currently 
active password file as stored on disk. Use this command to undo changes you have made to 
the currently active password file. 

Set Passphrase
Use this command to enter your passphrase. This passphrase will be used to encrypt your 
file. It is the encryption key. Please also read the "Encrypting Password Files" section below 
before using this feature. 

Export to Text
The Export to Text command exports all data from all cards to Tab Delimited text format. 
You might want to use this command when you want to use this data for a database. 

Import tom Text



The Import from Text command reads in data from a Tab Delimited Text file. 

Import from Keychain
The Import from Keychain will import all Internet passwords from the Keychain. 

Print
The Print command allows you to print the currently active password file. Some options in 
Preferences determine what is actually printed. To change the printer font, change this 
setting via Internet Config. 

Edit menu

The Edit menu has the following commands: 

Undo -  Z
Not yet implemented. 

Cut -  X
Move the currently selected card to the Clipboard. 

Copy -  C
Copy the currently selected password and selected card to the Clipboard. 

Paste -  V
Paste the contents of the Clipboard (this could be card). 

Delete
Delete the currently selected card. 

Select All -  A
Select all text. 

Generate Password -  M
The Generate Password command lets you generate a random password. 



 

●     Press the Generate button to generate a new password. 
●     Press the Clipboard button to copy the generated password to the Clipboard. 

Note: you can use the option 'Hexadecimal Digits' to generate WEP keys. For a 40 bits key 
use 10 characters, for a 104 bits key use 26 characters. 

Card menu

The Card menu has the following commands: 

Go -  L
The Go command launches the URL of the currently selected card. It switches to your 
browser and shows the password utility window, giving you access to all information of the 
card, like user ID and password. 

Add Card -  N
The Add Card command allows you add a new card to the currently active password file. 

Duplicate Card -  D
The Duplicate Card command duplicates the currently selected card. 

Change Category
The Change Category command moves the current card to another category. Select the 
destination category from the submenu. 

Internet menu



The Internet menu has the following commands: 

WWW -  B
The WWW command launches your Web Browser or switches to it if it is already running. 

FTP -  F
The FTP command launches your FTP program or switches to it if it is already running. 

Email -  Y
The Email command launches your Email program or switches to it if it is already running. 

Login -  L
The Login command launches your Telnet program or switches to it if it is already running. 

News -  N
The News command launches your News reader or switches to it if it is already running. 

Preferences

At Startup

Open 'Startup Items'
If the preference is checked, Web Confidential automatically loads the password files found 
in the folder with this path: 

~/Documents/Passwords/Startup Items/

The tilde character is the Unix shorthand for your home directory. 

If the a password file in the Startup Items folder is encrypted, you will be prompted for the 
key before it is opened. Default: on 

Install Shared Menus
If the Install Shared Menus option is checked, Web Confidential will install the Shared 
Menus Component at startup. If you prefer to run without Shared Menus, disable this 
preference. To deinstall the Shared Menus Component, remove from ~/Library/
Components/. First quit all your Internet applications before removing the Shared Menus 
Component. Default: on 

Show Shared Menus in Web Browsers Only
With Enable Shared Menus enabled, this option determines of Shared Menus are shown in 
all Internet applications or only in your Web Browser. Default: off 

Show Password Field as Text
For reasons of security and confidentiality, Web Confidential substitutes the contents of 
Password Fields as bullets. This option can switch this feature off. Default: off 



Allow Version Checking
When enabled, on startup Web Confidential will check the Web Confidential web site for a 
new version of Web Confidential. 

Helper Applications
If the Launch Web Browser option is checked, your Web Browser will be launched at 
startup. Default: off 

If the Launch FTP Client option is checked, your FTP program will be launched at startup. 
Default: off 

If the Launch Email Application option is checked, your Email program will be launched at 
startup. Default: off 

If the Launch Telnet Application option is checked, your Telnet program will be launched at 
startup. Default: off 

If the Launch News reader option is checked, your News reader will be launched at startup. 
Default: off 

Note: Internet Config settings determine which applications are actually launched. 

General tab

Look & Feel

Confirm When Deleting Cards
With this option enabled, you will be warned when you delete a card. Default: on 

Automatically Sort Categories
With this option enabled, the categories will remain sorted on name. Default: off 

Keep Notes Visible
By default, the note associated with a card is collapsed and can only be seen by expanding 
the disclosure triangle. To always show the note data, enable this option. 

Don't Show Eyeglasses Icon
Web Confidential displays the passwords in a help tag when you pass the mouse over the 
eyeglasses icon. For reasons of security or confidentiality this can be disabled. Default: off 

Use Metal Windows
Use metal windows like in Safari and the Finder in Panther. You need to close a document 
and re-open it to see the effect. Default: off 

Remember Desktop
To have Web Confidential remember the position of its main window, select this option. 



Default: off 

Saving Documents

Auto Save on Close
With this option enabled, your documents will be automatically saved when you close them. 
Default: off 

Auto Save every 'x' minutes
With this option enabled, your documents are automatically saved every 'x' minutes. Default: 
off 

Encryption tab

Use the "Blowfish" Algorithm
Web Confidential allows you to encrypt your password files with the Blowfish algorithm. To 
learn more about the "Blowfish" algorithm, press the Blowfish Home Page button. 

Internet tab

Browser
With the Browser popup menu, you can configure Web Confidential to recognize the Web 
Browser you use. Default: Safari. This allows you to have more than one Web Browser 
installed on your hard disk and have Web Confidential recognize the correct one. However, 
Web Confidential will first try to use the Internet Config settings, if these are available. 

Security tab

Security
Automatically locks documents after 'x' minutes of user inactivity. Default: off 

Backup
If the Automatic Backup option is turned on, Web Confidential will create a copy your 
previous password file when you choose the "Save" command. It will be called "<filename>.
bkup" Default: off 

Printing tab

Print ATM/PIN Codes
If the Print ATM/PIN Codes option is turned on, the ATM/PIN Codes field of the 
corresponding cards will be included when you issue a print command. Default: off 

Print Notes
If the Print Notes option is turned on, all Notes fields will be included when you issue a print 
command. Default: off 



Note: the printer font is Monaco. 

Encrypting Password Files

Web Confidential allows you to protect your password file with a so-called key or 
passphrase. A key is similar to a password. Once you have protected a password file with a 
key or passphrase, Web Confidential will prompt you for the key or passphrase each time 
you open this file. In addition, Web Confidential uses this key or passphrase to encrypt the 
password file. This provides provides excellent security for your password file. 

Encryption is a complex subject and discussion of it is beyond the scope of this document. 
Suffice to say that if you protect your Web Confidential password file with a key ten 
characters in length, it is extremely unlikely that anyone would be able to crack the code. 
Always create a key with mixed upper- and lowercase letters and numbers; such a key is 
more difficult to crack. Your key can even be a multi- word phrase (spaces are permitted). 
The key can be 56 characters (=448 bits) in length. 

To ensure that you type your key or passphrase correctly, Web Confidential prompts you to 
enter it twice. 

Unprotected password files and encrypted password files have slightly different icons; an 
encrypted password file is recognizable by an unbroken key depicted on the icon. This is to 
help you verify that a password file has indeed been encrypted. 

When to encrypt

Encryption is optional; Web Confidential does not require you to encrypt a password file. 
However, we think it is wise to always encrypt your password file. 

Warning
If you lose or forget the key you used to encrypt your Web Confidential password file, 
there is no way you will be able to access the data in this file. Do not even contemplate 
contacting us for help. We have not designed any kind of back-door mechanism in Web 
Confidential to enable us to open an encrypted password file without the key. If you 
have lost your key, your data is gone for good; your only recourse will be to re-enter all 
your data in Web Confidential manually. Our advice: if you encrypt your password 
file, use a key that you are certain you will never forget or keep a copy of your key in a 
safe place. 

Special Folders

The 'Startup Items' folder
Web Confidential automatically loads the password files found in a folder with this path: 

~/Documents/Passwords/Startup Items/



If a password file in the Startup Items folder is encrypted, you will be prompted for the key 
before it is opened. 

You can turn off the Startup Items feature by turning off the "Startup Items" option on the At 
Startup page of the Preferences Window. 

The 'Cabinet' folder
Files in the Cabinet folder are, together with the files in the Startup Items folder, listed in the 
Quick Open submenu of the File menu and the Cabinet submenu of the Diamond Shared 
Menu. 

The files in the Cabinet are also shown in the submenu Cabinet of the Mac OS X Dock 
popup menu. 

The path of the Cabinet folder should be: 

~/Documents/Passwords/Cabinet/

Also supported on Mac OS X is the Shared folder. 

/Users/Shared/Documents/Passwords/Cabinet/

Using the Mac OS X Dock

You have access to all your password cards via the Mac OS X Dock. Furthermore, you can 
use the Cabinet submenu to open your favorite password files quickly. 

Click on the Web Confidential icon in the Dock and hold down the mouse button. You can 
also Control-Click on the Web Confidential icon in the Dock. That is actually a little faster. 
A popup menu will show you all the categories in your password file. Move over a category 
to see the contents of the category. Choose a card from the submenu to load the that card in 
your web browser. 

Note: Web Confidential does not have to be the current active application. You can have 
Safari, Explorer or OmniWeb in front and then click on the Web Confidential icon to get 
access to your cards. 

Below an example screen shot. 



 



Keyboard Shortcuts
     A - Select All 

     C - Copy 

     V - Paste 

     D - Duplicate Card 

     E - Edit Card 

     F - Switch focus to the toolbar search field 

     K - Set Passphrase 

     G - Launch Card 

     N - Create a new card 

     O - Open password file 

     P - Print currently active password file 

     Q - Quit Web Confidential 

     W - Close currently active password file 

     Z - Undo (not yet implemented) 

     , - Show Preferences 

     M - Generate Password 

     B - Launch Web Browser 



     F - Launch FTP program 

     Y - Launch Email program 

     L - Launch Telnet program 

     N - Launch Newsreader 

Modifier Keys

Double click on a password item in the list view will edit a card. 

Option-double click on a password item in the list view will launch a 
card. 

Control-Click on a password item in the list view shows the contextual 
menu or action menu. 

Holding down the Command Key or Option Key while selecting a card 
from the Dock's popup menu will postpone the loading of the URL until 
you press the Internet Location Icon of the card in the Password Utility 
Window. 

Note:

     = Command Key 

     = Command + Shift Key 
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